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Create anew project. File->New Project
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[Form Layout X

Choose a standard executabl e.
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Caption
Returns/sets the text displayed in an
object's title bar or below an object’s

[Form Layout X

Duplicates

You'll now have ablank form. Y ou should probably saveit right away, giving it
aname.

Create adirectory for your project. Select File->Save Project As. Save your
filesin your directory.

It will ask you to name your form (MyFirstForm.frm) and your project
(MyFirstProject.vbp).
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If you close your form, you can reopen it from the Project Explorer in the upper
right corner of your workspace.
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General ‘ ]
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48y Labelt
Properties - Labell
= .
o Labell Label -
O Alphabetic |Categunzed|
U Label1
= alignment 0- Left Justify
B ppearance  1-3D
Autosize False
BackColor [ a+s000000F
Backstyle 1-Opague
BorderStyle 0 -Nane
Caption Label1
DatsField
DataFormat
Datatember
Datasource
Draglcon (Mone)
Draghods 0-Manual
Enabled True L‘
(Name)
Returns the name used in code to
identify an object.
Form Layout x|
Duplicates

Select the text tool from the toolbox and place a label on your form.

If your toolbox is not visible, select View->Toolbox.
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project - Projectt |
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=35 Project1 (MyFirstProject.vi
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Label1 Label

Alphabetic | Categorized |

Labell
Alignment 0 - Left Justify
Appearance  1-3D
Autosize False
BackColor [ a+s000000F
Backstyls 1 - Opadue
BorderStyle  0-None
Caption w label is super
DataField
DataFormat
DataMember
DataSource
Dragleon (Mone)
DragMads 0 - Manual
Enabled True

n
object's title bar or below an object's

[Form Layout X

Change the text in your label by editing its “ Caption” property.
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alignmerit 0- Left Justify
Appearance  1-3D
AutoSize False
BackColor [ a+s000000F
Backstyls 1-Opanue
BorderStyle 0- Hone

ot elis not cool
DataField
DataFarmat
Datatlember
Datasource
Dragleon (Mone)
Draghads 0 - Manual
Enabled True

Caption

object's title bar or below an object's

[Form Layout

=35 Project1 (MyFirstProject.vi
=73 Forms
-1 Form1 (MyFirstForm.

Label2 Label

Returns/sets the text displayed in an

Fin|

|

Create another label, changing its text too.
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Font: Font style
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webdings
) wingdings
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Eff
I~ Stikeout
I~ Underline

Western -
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=5 Project1
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DataSource
Draglcon
DragMads
Enabled

FareColor
Height
Index

Left
LinkItem
LinkMode
LinkTimeout
LinkTopic
Mouselcon

Font
Returns 3 Fort object

|

[Form Layout

-1 Form1 (MyFirstForm. frn)

KT I
Properties - Label 1 53
Label1 Label -

Alphabetic | Categorized |

DataMember -

(MyFirstProject.v|

(Mone)

0 - Manual
True

M5 Sans Set
W =Hs0000012
B15

B00

0 - None
s0

(Mone)

We can change the Font of our first label by changing its Font property.
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Label1 Label

Alphabetic | Categorized |

Appearance  1-3D
Autosize False

BackColor [ a+s000000F
Backstyls 1 - Opadue
BorderStyle  0-None
Caption My new label is :
DataField

DataFormat

DataMember

DataSource

Dragleon (Mone)
DragMads 0 - Manual
Enabled True

ignment
Returns/sets the alignment of a
CheckBo or OptionButton, or a

[Form Layout X

Duplicates

Add alittle alignment change to help make it super!
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Project - Project1 B
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=35 Project1 (MyFirstProject.vi
=73 Forms
-1 Form1 (MyFirstForm. frn)

KT I
Properties - Text1 53
Textl TextBox hd

Alphabetic | Categorized |

LinkTopic -

Lockzd False
MaxLength 0
Mouselcon (Mone)
MousePointer 0 - Default
MultiLine: False

OLEDragtode O - Manual
OLEDropMode 0 - Mone

PasswordChar

RightToLeft False

ScrolBars 0 - None:

TabIndex z

Tabstop True

Tag

_ Text1 |
Text

Returns/sets the text contained in the
control.

[Form Layout X

Creating atextbox isjust like creating alabel.

By default atext field isonly asingle line. You can change this with the

Multiline property.
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Command1 CommandButton

Alphabetic | Categorized |

(uame) Command1
Appearance  1-3D
BackColor [0 arzo00000F
Cancel False
Command1
Causestalidation True
Default False
DisablecPicture  (Mone)
DownFicture  (None)
Draglcan {hlane)
Draghods 0-Manual
Enabled True
Font MS Sans Serif
Height 75
HelpContestlD 0

Caption
Returns/sets the text displayed in an
object's title bar or below an object’s

[Form Layout X

Add another text box and a button.
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Project - Projec B
I[=)
=35 Project1 (MyFirstProject.vi

=73 Forms
-1 Form1 (MyFirstForm. frn)

Command1 CommandButton

Alphabetic | Categorized |

fHame) Command1

Appearance  1-3D
BackColor [0 arzo00000F
Cancel False

Uipdate Text
Causestalidation Trus

Defaulk False
DisabledPicture  (hlone)
DownFicturs — (Fons)
Draglcon (Mane)
DragMads 0 - Manual
Enabled True

Font MS Sans Serif
Height 375

HelpContextld O

Caption
Returns/sets the text displayed in an
object's title bar or below an object’s

[Form Layout X

Change the caption on your button.
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General
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Project - Project1 B
I[=)
=35 Project1 (MyFirstProject.vi

=73 Forms
-1 Form1 (MyFirstForm. frn)
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Properties - WriteText x|
& o
WriteTest TextBox -
(] T Alphabetic |Categunzed|
ol DD ] L
U . ez i wiribeText| -
= i i L alignment 0- Left Justify
@ e = Gl e cgpsaranc 1-30

5555 BackColor [ axso0o000s
Update Test
i ”—I = BorderStyle 1 -Fixed Single

CausesValidstion True

DataField

DataFormat

DataMember

Datasource

Dragleon (Mone)

DragMade 0 - Manual

Enabled True

Font M5 Sans Serif

ForeColor W =+z0000008 |
(Name)

Returns the name used in code to
identify an object.

Duplicates

We are going to refer to our text fields programmatically, so we should give
them meaningful names. Lets call them “ReadText” and “WriteText”.

Note thisis not the text in the text field that we're changing (that is the Text
property). Thisisthe name we useto refer to that text field. Lets set the Text
Property to a blank string while we're here.

13
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General ‘ ]
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=73 Forms
A ’a_b‘ B Form1 (MyFirstForm,Frn|
[ ject1 - Form1 (Form) N [=] ] B3 Formz {MysecondForm|
- X
P o M Project1 - Form1 {Code) (Ol x|
Command1 +| [ciick -
EH = —
- Frivate Sub Cormandl Click() =
ay 3 Debug.Print "--- In Commandl_cClick —--7 — T — ]
Properties - Command1 |
&= Debug.Print "WriteText.Text has valus: ", UriteText.Text [Command1 Commandsuton =]
Command1 CommandButton hd
O Debug.Print "ResdText.Text has valus: ", ReadText.Text
Alphabetic |Categunzed |
& ~ TriteText.Text = ReadTaxt.Text Commandl =
= fppearance  1-30
b Debug. Print "UriceText.Text has valus: ", UriceTexr.Text EarkColor [ adsaaaonoe
Debug.Print "ResdText.Text has valus: ", ReadText.Text el False
Caption Update Text
Debug.Priat "-—— Exiting Commandl_cClick ———" Causesvalidation True
End Sub Default False
Disabledpicture  (fone)
DownFicture  (Hone)
Dragicon {hone)
DragHade 0 -Manusl
Enabied True
Font MS Sans Serif
Height 375
Helptontextin 0 o
(Name)
Returns the name used in code to
identify an object.
[Form Layout x|

Duplicates

Double click on the command button to bring up its event handler. Add asimple
script that sets the value of the WriteText box to the text currently in the
ReadText box.

Note the Debug.Print statement. This can be very helpful in keeping track of
what your program is doing, so that you can understand why it isn’t working.
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=73 Forms

AutoRedrav
BackColor
Barderstyle
Caption
ClipContrats
ControlBox
DrawMads
Drawstyle
DrawWidth
Enabled
FillColor
Filstyle
Font

Appearance
Returns/sets whether or not an ohject
is painted at run time with 3-D effects,

[Form Layout

=35 Project1 (MyFirstProject.vi

-1 Form1 (MyFirstForm. frn)

Form1 Form

Alphabetic | Categorized |

[ &HannnnnnF
2 - Sizable
Forml

True

True

13- Copy Pen
0 - Solid

1

True

W &Hoooononc
1 - Transparent
M3 Sans Serif

|

Lets clean up our layout alittle bit and put simple labels on our text boxes.
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project - Projectt |
I[=]
=35 Project1 (MyFirstProject.vi
=73 Forms
-1 Form1 (MyFirstForm. frn)

Form1 Form

Alphabetic | Categorized |

AutoRedraw

BackColor [ &HannnnnnF
Borderstyle 2 - Sizahle
Caption Forml
ClpContrals — True
Controlgio:x True
Draniods 13- Copy Pen
Drawstyle 0 - Salid
DrawWidth 1

Enabled True

FillColor W &Hoooononc
Fillstyle: 1 - Transparent
Forl: M3 Sans Serif

Appearance
Returns/sets whether or not an ohject
is painted at run time with 3-D effects,

[Form Layout X

We can run our program with the Run->Start command.
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My
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super

Read Text

Update Text
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Immediate

Project - Project1 B
I[=)
=35 Project1 (MyFirstProject.vi

=73 Forms
-1 Form1 (MyFirstForm. frn)

We should fix that lousy window name “Form1”.
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Project - Projec B
I[=)
=35 Project1 (MyFirstProject.vi

=73 Forms
-1 Form1 (MyFirstForm. frn)

Form1 Form

Alphabetic | Categorized |

Appearance  1-3D
AutoRedraw  False

BackColor [ &HannnnnnF
Borderstyle 2 - Sizahle

and Witite Text
ClpCortrals — True
Controlgio:x True

Draniods 13- Copy Pen
Drawstyle 0 - Salid
DrawWidth 1

Enabled True

FillColor W &Hoooononc
Fillstyle: 1 - Transparent
Forl: M3 Sans Serif

Caption
Returns/sets the text displayed in an
object's title bar or below an object’s

[Form Layout X

It’s the Caption property on the form.

18



[run]

Fle Edt Yiew Project
i 27 4800 x 3600

NEIEY

|=-%- 5]

EEIE a0

My
new

Fiead Text T here, Like thi
label el
is

Wite Text
super

Update Text

But this label is
ot cool

Immediate

ct - Projectl B
I[=)
=35 Project1 (MyFirstProject.vi

=73 Forms
-1 Form1 (MyFirstForm. frn)

Now we can type text in the top box.
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I[=)
=35 Project1 (MyFirstProject.vi

=73 Forms
-1 Form1 (MyFirstForm. frn)

Click the button and the text is copied into the other box.
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3 Add MO Form
¥2 Add Module
2 Add Class Maduls
“H Add User Control
3] Add Property Page
@) Add User Document
Add File... ChrD
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-LHEETE - | o - MERYRA[ - oo 2% 4800 x 3500
5
=35 Project1 (MyFirstProject.vi
=73 Forms

Remove MyFirstForm. frm

B References...
Companents. ChrT

Project! Properties. .

-1 Form1 (MyFirstForm. frn)

Alphabetic | Categorized |

|I—

[Form Layout X

Now we will add a second form to our project.
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B Data Form  About Diglog Diglog Log in Dialog
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ODBC Log In - Options Dislog Splash Screen Tip of the Day  Web Browser
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=35 Project1 (MyFirstProject.vi
=73 Forms
-1 Form1 (MyFirstForm. frn)

Alphabetic Categuwed'

|I—

[Form Layout X

Use the standard “Form” type.
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= Open Projeck... Chl+Q ject - Projec
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‘ Remove Project =35 Project1 (MyFirstProject.vi
=73 Forms
[ save Project.

-1 Form1 (MyFirstForm. frn)
3 Formz (Formz)

Save FOIm2 A5, .
Save Selection
Save Change Scrpt

ject1 - Formz (Form)

S prirt... Chrl+P
[ Frirt setup. .

KT I
perties - Form2 53
Form2 Form

Make MyFirstProject. sx...
Pake Praject Group,.,

PiyFirstProject vbp
\sortdownsartdawn. vbp
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.wbbenchiVideoPeoplsBenchmark.vbp

1
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Exit Alt+Q

Duplicates

Alphabetic Categuwed'

B Appearance
Appearance 1-3D
BackColor [ arzoo0nn;
Borderstyls 2 - Sizable

Formz
FillColor W &Ho0n0n;
< L FillStyle 1 - Transparer

FontTransparen True
ForeColar W &HE00000

Palette (hane)
Ficture (None)
B Behavior

AutoRedraw False
ClipControls  Trus
DrawMode 13- Copy Pen

Caption
Returns/sets the text displayed in an
object's title bar or below an object’s

[Form Layout X

Save the form, giving

its file ameaningful name (MySecondForm.frm).
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.. .. ol R ol
L] odal = Modeless
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Project - Project1 B3
I[=)
=35 Project1 (MyFirstProject.vi
=73 Forms
-1 Form1 (MyFirstForm. frn)
3 Farmz (MySecondForm,|

Properties - Madal 53

Modal CommandButton -

Alphabetic | Categorized |

Modal
ppearance  1-3D
BackColor [0 arzo00000F
Cancel False
Caption Modal
Causestslidation True
Default False
DisablecPicture  (Mone)
DownFicture  (None)
Draglcan {hlane)
Draghods 0-Manual
Enabled True
Font MS Sans Serif
Height 75
HelpContestlD 0 =

(Name)

Returns the name used in code to
identify an object.

[Form Layout X

WE're going to open this second form from our first form. We'll have two

buttons for opening it. We'll call these buttons “Modal” and “Modeless’, setting

the (Name) property and the Caption property of each button.
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=73 Forms
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F o BBl = Project1 - Formt {Code) I =] 3

Modeless +| [ciiek -

Ef BB o Private Sub Commandl Click(] =
ay g WriteText.Text = ReadText.Text = N
@ = eo End Sub Properties - Modeless x|
N o Private Sub Nodal Click() Modeless Commandéutton |
O o FormZ .Show vhModal, Ne Alphabetic |Categunzed|
B~ oo End Sub Modeless
= ) ppearance  1-3D
b Private Sub Nodeless Click() ackColor [ sero000000F
FormZ.Show vhHodeless, He Cancel Falss
End Sub (Caption Modeless
Causestslidation True
Default False
DisablecPicture  (Mone)
DownFicture  (None)
Draglcan {hlane)
Draghods 0-Manual
Enabled True
Font MS Sans Serif
Height 75
HelpContestlD 0 =
(Name)
Returns the name used in code to
identify an object.

Duplicates

Double clicking on Modal and Modeless will give us event handlers. We'll have
Modal call the Show method of Form two with the vbModal parameter.
Modeless will call with the vbM odel ess parameter.

Note that Me indicates that Form1 is the parent form for Form2. Itskind of like
the this keyword in other languages.



#5, Project1 - Microsoft Yisual Basic [design]

Ele Edit Yiew Project

P

EIE

B2 @HE| s =R o]y ) on BE S YR E| e

. Project1 - Formz2 {Form)
CEETEET -loix

E

General

v

Show me the code

RS

El
]

Gk
0

OB
U
(=

=18lx]

Duplicates

1 airEx 13

Project - Project1 B
I[=)

=35 Project1 (MyFirstProject.vi
=73 Forms

-1 Form1 (MyFirstForm. frn)

3 Form2 (ySecondForm,|

KT IS
Prop: ShowMeTheCode B3|
ShowMeTheCo« CommandButton

Alphabetic | Categorized |

BhowMeTheCor &

ppearance  1-3D
BackColor [0 arzo00000F
Cancel False
Caption Show me the co
Causestslidation True
Default False
DisablecPicture  (Mone)
DownFicture  (None)
Draglcan {hlane)
Draghods 0-Manual
Enabled True
Font MS Sans Serif
Height 1335
HelpContestlD 0 =
(Name)

Returns the name used in code to
identify an object.

[Form Layout X

WEe'll put abutton on Form2. We'll just be using this button to illustrate some

things about how to code in Visual Basic.
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Private Sub ShowMeTheCode Click()

' ¥ou can just declare variables in cods
HyVWariable = "abcdefghi”

' But if you do this, they're untyped (called a variant type)
HyVarisble = 7

! ¥ou declare typed varishles with Dim .. &s ..
' This is good programming style, and will help with debugging
Dim MyDouble ks Double
Dim MyString ks String

! There's @ set of functions, CIat, CStr, CDbl for converting
! hEtWEENn LYpPES

HyString = C3tr(8.777)

HyDouble = CDbI(MyString

! The Debug.Print method will print things when you run
' your programs in debug wode
Debug.Print "Hello from the debugger: ", HMyDouble

' ¥ou can also put up message hoxes
MsgBox "MessageBox: " + CStr(MyDouble), vhOKCancel, "Test™
End Sub
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Returns the name used in code to
identify an object.
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Variablesin VB by default can store any value you put in them. So the same
variable can store the String “cat”, the Integer 7, or the Double 4.33. But you
would be responsible for keeping track of what isin avariable.

So you can instead declare your variable to be a particular type, such as String,
Integer, or Double.
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Another button for us to put some more code in.
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= ' This iz a siwmple function. You "return” by setcing a value to the nawe =
L ' of the function. If you vant to exit also, call exit funetion =1 [=-15 Project1 (MyFirstProject.vl
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Private Function SquareDoubleiInputDouble As Doukle) As Double

ab
A ol SruareDouble = InpurDouhle # TnputDouble 3 Formt (MyFirstForm. Frol
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= End Function
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Parentheses for function calls are generally optional in VB,
we need them here hecause we're waking an assignment using the C

return value of the function
HyString = InputBox ("Enter a number for me to sgquare”, "Input!")
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Private Sub ShowMeTheCode_Click()
' fou can just declare variables in code
HyVariable = "abodefghi”

Returns/sets the text displayed in an
object's title bar or below an object’s
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' But if you do this, they're untyped (called a variant type)
HyVarishle = 7

' You declare typed varishles with Dim .. A3 ..
' This is good programming style, and will help with debugging =
3
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We have defined the SquareDouble function here. Given adouble as a
parameter, it squares that double and returns the value. Note the weird VB
syntax, we don't return avalue. Weinstead set the name of our function to a
value.

Note the IsNumeric function. It isapretty hard problem to determineif a String
contains atext representation of anumber. Luckily, this, like most everything
else you will want to do, has already been written for you.



